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MENYIAPKAN NASKAH ANDA DENGAN            

MS WORD 2010 

 

 

άBerfikir komplek sering kali tidak banyak membantu 
menyelesaikan persoalan Anda, berfikirlah sebagaimana Anda 

perlukanΦέ 
ά{ȅŀƳǎǳƭ !ǊƛŦƛƴέ  

 

Menulis buku setidaknya meliputi pekerjaan tiga pekerjaan utama. Pertama 

mengalirkan ide-ide atau pengetahuan dalam bahasa tulisan, kedua, 

mengkonstruksi ide-ide dan pengetahuan tersebut menjadi aliran yang logis, 

sistematis, mengalir dan enak dibaca. Ketiga, Mengatur tulisan dalam sebuah 

dokumen atau naskah yang sesuai dengan standar dan kaidah penulisan buku 

yang benar. Seringkali seorang penulis buku begitu sulit menuangkan ide-

idenya atau pengetahuannya karena terkendala oleh rumitnya aturan dan 

kaidah menulis. Ditambah lagi dengan penguasaan media tulis yang pas-pasan, 

misalnya seperti media tulis MS. Word. Menurut hasil survey pada umumnya 

pengguna MS Word hanya memanfaatkan kemampuan MS Word kurang dari 

15%. 

Pada bab ini akan saya ajak Anda untuk learning by doing bagaimana 

memanfaatkan fitur-fitur MS. Word 2010 yang sangat ópower fullô itu untuk 

mempersiapkan naskah buku Anda. Mulai dari bagaimana membuat style, 

template, mengatur halaman, membuat kutipan dan bibliografi, membuat 

nomor gambar-grafik-tabel otomatis, membuat indeks, dll. Yang Anda 

perlukan untuk memahami bab ini adalah sedikit membaca dan banyak 

mencoba, hasilnya pasti Anda akan terkejut, dan bisa jadi Anda tidak percaya 

kalau Anda bisa melakukannya. 

1.1  Sekilas Tentang MS Word 2010 

MS Word 2010 merupakan salah satu program pengolah kata yang paling 

populer di Indonesia bahkan didunia, penggunanya sekitar 80%-90%. MS 

Word 2010 telah dilengkapi fitur-fitur yang memudahkan pengguna, 
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khususnya dalam menyiapkan naskah-naskah berupa buku, artikel, surat dan 

bentuk-bentuk dokumen lainnya. 

Banyak hal yang membedakan antara fasilitas-fasilitas atau fitur-fitur yang 

dimiliki oleh MS Word 2010 dengan MS Word versi sebelumnya. Yang jelas 

MS Word 2010 akan memudahkan dan memanjakan pengguna sekaligus 

makin user friendly.  

Diantara fasilitas baru yang dimiliki oleh MS Word 2010 adalah; 

  

ANTAR MUKA YANG FLEKSIBEL 

Antar muka terdiri dari beberapa bagian penting yang memudahkan kita untuk 

bekerja mempersiapkan naskah buku kita, diantaranya adalah ribbon yang 

sederhana dan intuitif sehingga Anda dapat menemukan dan mengolah 

denkumen Anda dengan mudah dan cepat. Ribbon tersebut diantaranya File 

Tab, Quick Access Toolbar, Dialog Access Launcher, Contextual Tabs, 

Galleries, dan Zoom and View, dll. Dapat dilihat pada gambar dibawah. 

 

Gambar 1-1: Halaman Utama MS Word 2010 
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File Tab, 

Jika Anda klik File Tab akan terlihat layar BackstageTM yang terdapat fasilitas 

Print, Save, Edit, setting Options dan juga kastemisasi ribbon. 

Quick Access Toolbar (QAT) ,  

Fasilitas ini yang sangat berguna untuk mengakses secara cepat apa yang Anda 

ingin kerjakan. Misalnya untuk save dokumen, Anda cukup klik pada ikon 

kecil bergambar disket. Untuk menambah atau atau mengurangi ribbon pada 

QAT, silahkan Anda klik kanan, selanjutnya pilih dan klik Tab yang Anda 

inginkan.  

Dialog Access Launcher (DAL) ,  

Jika Anda klik DAL (berupa anak panah kecil menghadap miring kebawah) 

akan muncul secara cepat layar yang berisi pilihan-pilihan yang Anda perlikan 

untuk mengolah dokumen Anda. 

Contextual Tabs (CT), 

CT akan muncul secara otomatis jika Anda melakukan klik pada gambar, tabel, 

grafik dalam dokumen Anda untuk selanjutnya dilakukan editing.  

Galleries, 

Galleries menyediakan berbagai pilihan format dengan objek kerja tabel, 

gambar, dan kotak teks. 

Zoom and View, 

Fasilitas ini sangat bermanfaat untuk memperkecil atau memperbesar tampilan 

layar kerja pada dokumen Anda.  

 

NAVIGASI PANE & SEARCH DOCUMENT YANG EFISIEN 

Ini adalah fitur baru yang tidak dimiliki  oleh MS Word versi yang lama. 

Merupakan fasilitas untuk pencarian kebagian-bagian dokumen yang Anda 

butuhkan. Pencarian tidak hanya terbatas pada pencarian teks saja, namun juga 

gambar, tabel, persamaan, catatan kaki, dll. 

 

BEKERJA DALAM TIMEWORK 

Anda dengan mudah dapat mengedit dokumen dalam timework pada saat yang 

bersamaan dengan menggunakan MS Word 2010. Fasilitas ini juga tidak 

dimiliki oleh MS Word versi sebelumnya. 
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EFEK VISUAL TEKS DALAM DOKUMEN 

Anda dapat memberikan efek tiga dimensi pada teks, gambar, dan diagram. 

Seperti efek bayangan, cahaya, bevel, tata warna, dll. Tujuan dari fasilitas baru 

ini untuk memberikan kemudahan dan memotivasi pembaca teks hasil kerja 

Anda. Disamping itu untuk buku-buku pembelajaran dan buku referensi efek 

tiga dimensi atau visual ini dapat membantu membangun imajinasi pembaca, 

dan mempermudah pemahaman. 

 

AKSES DOKUMEN BISA DENGAN WEB 

MS Word 2010 menyediakan fasilitas untuk menyimpan, membaca, mengedit 

dokumen secara online. Jadi jika Anda dengan dokumen pada blog Anda, Anda 

bisa langsung bekerja secara online dengan menggunakan fasilitas MS Word 

2010. 

 

8 SCREENSHOT YANG MEMUKAU  

Ada 8 ribbon tab yang akan mempermudah pekerjaan Anda mengolah 

dokumen yang disediakan oleh MS Word 2010. Tujuh tab sudah ada pada 

tampilan MS Word 2007, sedangkan satu tab merupakan tampilan baru pada 

MS Word 2010, yaitu File Tab, yang berada di bagian kiri layar. 

Home tab,  

berisi fitur-fitur untuk memformat font, mengatur paragraf, membuat styles 

dan editing 

Insert tab, 

Berisi fitur-fitur untuk memasukkan teks, gambar, grafik, table, shapes, simbol 

dan persamaan matematika dalam naskah Anda. Membuat header dan footer, 

membuat caver halaman dan mengatur halaman yang berbeda. 

Page Layout tab, 

Berisi fitur-fitur untuk setup halaman, mengatur indent dan spacing paragraf, 

mengatur gambar dalam tiap halaman teks, mengatur background halaman dan 

mengatur warna, fonts dan memberikan efek-efek tiga dimensi tertentu. 

Reference tab, 

Berisi fitur-fitur yang sangat diperlukan untuk membuat buku dan artikel 

ilmiah. Fitur pada table of contents untuk membuat daftar isi, daftar gambar, 

dan daftar tabel secara otomatis. Fitur pada Footnote untuk memberikan 

catatan kaki, mengatur kutipan dan rujukan dengan menggunakan fitur 

citations & Bibliography. Membuat indeks dengan fitur Index. Membuat 

cross-reference pada halaman yang berbeda pada teks naskah, dll. Lebih lanjut 
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akan dibahas pada bagian selanjutnya bab ini, silahkan Anda meneruskan 

membaca. 

Mailings tab, 

Berisi fitur-fitur untuk cetak halaman naskah ke alamat yang berbeda yang 

telah ada dalam database. Fitur ini sangat berguna untuk keperluan dokumen 

berupa surat-menyurat. 

Review tab, 

Berisi fitur-fitur yang sangat berguna untuk proofing ejaan, tata bahasa, periksa 

kosa kata dalam kamus dan menghitung jumlah kata dalam paragraf atau 

dokumen. Serta fitur ini sangat berguna bagi editor, atau reviewer untuk 

memberikan catatan yang harus diperhatikan oleh penulis, dll. 

View tab, 

Berisi fitur-fitur untuk merubah tampilan view dokumen, zooming, ruler, 

gridlines, dll. 

File tab, 

File tab pada MS Word 2010 memberikan kemudahan bagi pengguna untuk 

melakukan pencarian halaman, gambar, tabel, persamaan, dll. dalam dokumen 

Anda. Juga dengan tab ini Anda dapat melihat dan menuju pada bab, sub-bab 

dan bagian-bagian tertentu dengan klik pada layar Navigation. File tab ini 

merupakan pengembangan dari fitur Find pada versi MS Word sebelumnya. 

1.2  Mengatur Fasilitas Ejaan Bahasa 

MS Word 2010 menyediakan fasilitas untuk pemeriksaan kata atau ejaan 

bahasa dalam dokumen Anda. Ejaan bahasa dalam MS Word diatur secara 

default sesuai dengan pilihan bahasa yang digunakan oleh OS Windows, 

biasnya menggunakan bahasa Inggris (EN).  

Pemeriksaan ejaan bahasa oleh MS Word dilakukan dengan dua cara. Cara 

pertama pemeriksaan secara otomatis pada setiap kosa kata yang Anda ketik. 

Biasanya ditandai oleh garis bawah bergelombang bewarna merah, jika terjadi 

kesalahan ejaan. Cara kedua pemeriksaan yang dilakukan sekali pada akhir 

pengeditan naskah.  

MEMATIKAN & MENGHIDUPKAN EJAAN OTOMATIS 

Fitur ejaan otomatis dapat dimatikan dan diaktifkan melalui ribbon File. Jika 

Windows nya disetting dg bahasa Inggris, maka ejaan otomatis bahasa Inggris 

merupakan default setting pada MS Word. Hal ini dapat dilihat pada layar 

dengan melakukan klik pada ribbon File, kemudian klik Options, lalu klik 

Proofing akan tertampil layar sbb., 
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Gambar 1-2 Pengaturan Menghidupkan Ejaan & Grammar Otomatis 

Maka setiap kata yang bertanda garis gelombang warna merah adalah kata 

yang perlu dikoreksi. Cara mengoreksinya, lakukan klik kiri pada mouse, lalu 

akan muncul layar yang pada bagian atasnya terdapat satu atau beberapa 

pilihan kata,pilihan kata ini merupakan koreksi dari kata yang diberi garis 

tersebut.    

Sedangkan untuk  mematikan ejaan otomatis, lakukan langkah  berikut; 

hilangkan tanda check pada kotak Check spilling as you type, Mark 

Grammar errors as you type dan Check grammar with spelling, kemudian 

klik tombol OK . 

 

 

Gambar 1-3 Pengaturan Mematikan Ejaan & Grammar Otomatis 

MEMERIKSA EJAAN BAHASA DOKUMEN 

Pemeriksaan ejaan bahasa pada dokumen dapat dilakukan secara bersama, 

dimulai dari posisi kursor pada dokumen terus kebawah sesuai dengan 
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keinginan Anda. Untuk melakukannya matikan terlebih dahulu pemeriksaan 

ejaan otomatis terlebih dahulu.  Lalu letakan kursor pada awal dokumen yang 

hendak diperiksa ejaannya. Pilih dan klik ribbon Review, lalu pilih dan klik 

Spelling & Grammer, akan muncul layar sbb., 

 

 

Gambar 1-4 Layar Pemeriksaan Spelling and Grammar 

Pada kotak Not in Dictionary , kata ôdisettingô tidak terdapat dalam kamus, 

maka pilihan kata penggantinya dapat dilihat pada kotak Suggestions. 

Hal-hal yang perlu diketahui dari layar tersebut diatas adalah, 

Tombol Ignor Once untuk membiarkan kata tersebut, 

Tombol Ignore All untuk membiarkan seluruh kata yang sama dalam naskah, 

Tombol Add to Dictionary untuk menambah kata tersebut dalam kamus MS 

Word, 

Tombol Change untuk mengganti kata tersebut dengan pilihan kata yang ada 

di kotak Suggestions, 

Tombol Change All untuk mengganti seluruh kata yang sama dalam dokumen 

dengan pilihan kata yang ada di kotak Suggestions, 

Tombol AutoCor rect untuk memasukan kata tersebut dengan kata yang sudah 

dipilih dari kotak Suggestions ke dalam fasilitas AutoCor rect. 

Jika Anda sudah merasa selesai melakukan koreksi ejaan tekan tombol OK. 
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MENGEDIT KAMUS 

Mengedit kamus dapat dilakukan ada saat melakukan editing ejaan seperti 

dijelaskan pada bagian Memeriksa Ejaan Bahasa Dokumen diatas, juga dapat 

dilakukan dengan cara sebagai berikut, 

Pada ribbon File, klik Options, klik Proofing, klik Custom Dictionaries, 

akan muncul layar sbb., 

 

 

Gambar 1-5 Layar Option Editing Kamus 

Pada kotak Dictionary List akan muncul kamus bahasa dengan ekstensi .dic. 

Pilih dengan klik pada kamus CUSTOM.DIC , lalu klik tombol Edit Word 

List , selanjutnya akan muncuk layar sbb., 
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Gambar 1-6 Layar Editing Kosa Kata dalam Kamus 

Dari gambar layar diatas, untuk menambahkan kosa kata dalam kamus, ketik 

kata tersebut pada kotak Words(s), sedangkan untuk menghapus kata dalam 

kamus, maka pilih kata dalam kotak Dictionary, lalu klik tombol Delete, 

sedangkan untuk menghapus semua kosa kata klik tombol Delete all. 

1.3  Membuat Sistem Penomoran Halaman 

Pada saat Anda memutuskan bahwa naskah buku seluruhnya ditulis dalam satu 

dokumen atau file. Anda akan akan memerlukan sistem penomoran yang 

berbeda. Seperti yang dijelaskan pada bab terdahulu, buku dapat dibagi 

menjadi tiga bagian utama. Bagian preliminaries, yaitu bagian buku  yang 

terdiri dari halaman Perancis hingga daftar isi dan biasanya diberi penomoran 

dengan angka Romawi (i, ii, iii dst). Sedangkan pada bagian utama isi buku 

(Text Matter) hingga bagian postliminaries biasanya menggunakan penomoran 

dengan angka Arabic (1, 2, 3 dst).  

Langkah-langkah untuk membuat sistem penomoran yang berbeda dalam satu 

dokumen, sebagai berikut: 

1. Letakkan kursor di awal naskah dengan menekan tombol Ctrl+Home. 

2. Pada MS Word 2010 klik ribbon Insert, lalu klik segi tiga kecil pada 

tombol Page Number sehingga muncul menu pilihan. Klik Format Page 

Numbers. 



14 Sukses Menulis Buku untuk Diterbitkan 

 

 

Gambar 1-7  Layar Tab Format Page Numbers 

3. Setelah muncul kotak dialog Page Number Format, melalui kotak Number 

format pilihlahlah format i, ii, iii, .... , sedang pada kotak Start at ketikkan 

i.  

4. Klik tombol OK . 

 

Gambar 1-8 Layar Untuk Memformat Nomor Halaman 

Hasil dari langkah di atas, keseluruhan dokumen akan diberi nomor halaman 

dengan format Romawi.  

Langkah berikutnya adalah memberi batas, mulai halaman yang mana 

penomoran akan diubah menjadi nomor Arabic. 

Langkahnya sebagai berikut: 

1. Bawalah kursor ke halaman terakhir bagian Preliminaries. 

2. Klik ribbon Page Layout , klik tab Breaks, sehingga akan ditampilkan 

menu drop-down. Klik tab Next Page pada Section Breaks. 
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Gambar 1-9 Membuat Section breaks halaman 

3. Akan muncul section baru yang secara otomatis akan diberi nama Section 

2 pada halaman berikutnya. Pindahkan kursor ke halaman berikutnya yang 

telah berstatus Section 2. 

4. Kembali klik ribbon Insert, klik Page Number, klik Format Page 

Number. 

5. Pada kotak dialog yang muncul pilihlah pada kotak Number format 

dengan format 1, 2, 3... 

6. Pada kotak Start at ketikan dengan angka 1. 

7. Klik OK. Maka section 2 ini akan menggunakan penomoran Arabic 

dimulai dengan halaman nomor 1. Di halaman berikut ini kami perlihatkan 

ilustrasi yang menggambarkan page 8 (Section 1) bernomor halaman viii, 

sedang page 9 (Section 2) bernomor halaman 1. 

 

Gambar 1-10 Section 1 dan Halaman Tercetak xi (Angka Romawi) 

 

Gambar 1-11 Section 2 dan Halaman Tercetak 1 (Angka Arab) 
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1.4  Membuat Cover Page 

Pada umumnya sebuah naskah buku terdiri dari 4 section yaitu cover 

depan (cover page), preliminaries, text matter, dan postliminaries, seperti yang 

telah diuraikan pada bagian 7 tentang anatomi buku. Mari kita tabulasi uraian 

tesebut untuk mempersiapkan naskah kita sbb., 

Tabel 1-1  Empat section anatomi naskah buku 

Section Elemen Anatomi Buku Penomoran 

1 Cover page Tampa nomor 

2 Preliminaries ; 

¶ Hlm. Perancis (france title), 

¶ Hlm. Judul Utama, 

¶ Hlm. Copyrights, 

¶ Hlm. Persembahan (dedication), 

¶ Hlm. Ucapan Terima Kasih 

(acknowledgments), 

¶ Hlm. Daftar Isi, 

¶ Hlm. Daftar Tabel, 

¶ Hlm. Daftar Gambar/grafik, 

¶ Hlm. Daftar Simbul/lambang, 

¶ Hlm. Daftar Singkatan, 

¶ Hlm. Kata Pengantar (Foreword), 

¶ Halaman Prakata (Praface), 

¶ Halaman Pendahuluan(Introduction) 

Romawi 

3 Text Matter (body taxes) : Terdiri dari bab-

sub, dst. atau terdiri dari bagian-bagian. 

Arab 

4 Postliminaries; 

¶ Hlm. Daftar Pustaka (bibliography), 

¶ Hlm. Epilog (jika ada), 

¶ Hlm. Daftar Istilah (Glosarium/Senarai), 

¶ Hlm. Catatan Akhir, 

¶ Hlm. Lampiran-Lampiran, 

¶ Hlm. Indeks, 

¶ Hlm. Biografi Penulis. 

Arab/Alfabet 
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Mari kita membuat cover page naskah buku kita dengan langkah-

langkah sebagai berikut, 

1. Letakkan kursor pada halaman pertama naskah kita; 

2. Klik tab Insert > klik Caver Page, lalu pilih model caver page yang Anda 

kehendaki; 

 

Gambar 1-12 Layar pilihan cover page 

3. Untuk menghapus caver page klik tab Insert > Cover Page > Remove 

Current Page; 

4. Setelah Anda menyisipkan cover page, jangan lupa Anda klik tab Page 

Break untuk beralih ke halaman berikutnya, yakni halaman preliminaries 

yang menggunakan sistem penomoran romawi pada section 2 naskah 

Anda. 

1.5  Menyiapkan Dokumen dengan Style 

Style adalah merupakan kumpulan pengaturan format yang disimpan dengan 

nama tertentu. Mengolah dokumen dengan menggunakan style akan memiliki 

manfaat, 

1. Dokumen akan mudah dibaca dan konsisten; 

2. Dokumen terlihat rapi dan profesional; 

3. Akan mudah melakukan perujukan dan pengolahan daftar pustaka atau 

bibliografi; 

4. Jika dilakukan perubahan properti style, semua teks dalam dokumen akan 

mengikuti perubahan tersebut dengan sangat cepat; 

5. Pembuatan daftar isi, daftar gambar, dapat daftar tabel dilakukan dengan 

mudah dan konsisten. 
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MEANFAATKAN STYLE SIAP PAKAI & QUICK STYLE GALLERY 

MS Word 2010 menyediakan style siap pakai, Anda bisa dapatkan dengan klik 

Home, perhatikan pada group Styles dan klik anak panah yang menghadap ke 

kanan bawah, akan muncul layar pilihan style seperti terlihat pada layar paling 

kanan Gambar 1-14, diantaranya adalah, 

Normal, biasanya pilihan style untuk teks utama, 

Heading 1, biasanya pilihan style untuk judul bab (level 1), 

Heading 2, biasanya pilihan style untuk judul sub-bab (level 2), 

Heading 3, biasanya pilihan style untuk judul sub-sub-bab (level 3), dst. 

MS Word 2010 juga menyediakan Quick Style Gallery yang siap Anda 

gunakan untuk mengatur, mempercantik dan memberikan kesan profesional 

pada dokumen Anda. Untuk menggunakan Quick Style lakukan langkah 

berikut, 

Pilih dan klik tab Home, klik Change Styles, klik Style Set, akan muncul layar 

seperti gambar dibawah. Terlihat pada layar Style Set, tersedia 11 pilihan style 

dan satu style Default (Black and White). Silahkan Anda pilih salah satunya 

dengan klik pada tab yang Anda kehendaki. Pada gambar layar dibawah adalah 

contoh pilihan style Modern. 

 

Gambar 1-13 Layar Quick Style 

MEMBUAT STYLE DOKUMEN SENDIRI 

Jika Anda belum puas dengan style yang disediakan oleh MS Word 2010, 

Anda dapat membuat style sendiri dengan langkah-langkah sbb., 
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1. Pilih ribbon Home dan pada group Styles klik tombol kecil dengan tanda 

panah miring kebawah atau tekan keyboard CTRL+ALT+SHIFT+S , MS 

Word akan menampilkan panel Styles.  

2. Pada bagian bawah panel Styles (perhatikan lingkaran elip no.1), klik 

tombol New Style, dan akan muncul layar Create New Style From 

Formating, perhatikan Gambar 1-14 di bawah, 

3. Pada kotak Style Type, ada drop-down pilihan Paragraph, Character, 

Linked  (Paragraph And Character), Table, atau List  sesuai yang 

diperlukan. 

4. Character, mengatur format karakter seperti jenis dan ukuran font, warna 

dan efek font. 

5. Paragraph, mengatur format paragraf, seperti spasi, tab, border, 

penomoran, dan paragraf dengan bullets. 

6. Table, mengatur format tabel agar konsisten untuk border, shading, 

perataan dan font yang digunakan. 

7. List , mengatur format perataan yang sama, penomoran, karakter dengan 

bullets, penggunaan font dalam list (daftar). 

8. Linked , mengatur format kombinasi antara karakter dan paragraf. 

 

 

Gambar 1-14 Layar Create New Style from Formatting 

2 

1 



20 Sukses Menulis Buku untuk Diterbitkan 

 

9. Dalam daftar menu drop-down Style Based On menampilkan style yang 

sudah ada, biasanya kita tidak perlu untuk mengubah pilihan ini.  

10. Dalam daftar menu drop-down Style For Following Paragraph, pilih 

style yang kita inginkan digunakan oleh MS Word untuk paragraf yang 

mengikuti. (Pengaturan ini hanya berlaku untuk Paragraph Styles dan 

Linked Styles).  

11. Kotak Formatting  berisi pilihan untuk mengubah format style, meliputi 

jenis, ukuran, warna, bold, italic atau underline pada font yang akan 

digunakan. 

12. Gunakan pengaturan pada baris kedua pada kotak Formating untuk 

mengatur alignment, line spacing (spasi baris), spasi paragraf, dan 

indensasi.  

13. Sedangkan untuk format tipe lainnya, klik tombol Format pada bagian 

bawah sebelah kiri Gambar 1-14 (lingkaran elips no.2), Anda bisa memilih 

untuk memformat Font, Paragraph, Tabs, Border, Language, Frame, 

Numbering, atau Shortcut Key dari menu drop-down, kemudian silahkan  

masing-masing kotak dialog diisi sesuai dengan apa yang Anda inginkan.  

14. Pada bagian bawah kotak dialog, klik  tombol New Document Based On 

This Template, jika Anda ingin menyimpan style baru dalam dokumen 

sebagai template, sebaliknya klik  tombol Only In This Document. Dengan 

menyimpan style dalam bentuk template, Anda bisa menggunakannya 

setiap saat untuk mengolah dokumen-dokumen Anda lainnya. 

15. Verifikasi bahwa kotak Automatically Update tidak dipilih/dicentang.  

16. Klik  kotak Add To Quick Style List apabila kita ingin menambahkan style 

tersebut ke dalam daftar Quick Style.  

17. Klik pada tombol OK , jika Anda merasa telah cukup membuat style 

tersebut. 

 

CONTOH MEMBUAT STYLE TEKS UTAMA (BODY TEKS), 

Kita definisikan style teks utama (body teks) naskah buku dengan langkah-

langkah sbb.: 

1. Buka kotak dialok dengan menekan tombol Ctrl+Shift+Alt+S; 

2. Klik tombol New Style (ikon paling kiri, pada lingkaran-1, Gambar 1-14), 

lalu akan muncul kotak dialog Create New Style from Formatting; 

3. Pada kotak Nama, isikan nama style; Body Teks; 

4. Pada kotak Style type, pilih Paragraf; 

5. Pada kotak Style based on, pilih Normal (maksudnya body teks ini 

menggunakan style Normal yang disediakan pada styles gallery); 
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6. Pada kotak Style for following paragraph, pilih Body Teks, maksudnya 

adalah setiap Anda mengakhiri paragraf lalu tekan Enter, otomatis style 

berikutnya tetap Body Teks; 

7. Selanjutnya silahkan Anda pilih jenis font, ukuran font, alignment, dll. 

Pada bagian Formatting; 

8. Kalau Anda sudah merasa cukup, tekan tombol OK. 

 

CONTOH MEMBUAT STYLE JUDUL BAB, 

Style judul bab naskah Anda dapat dibuat dengan langkah-langkah sbb., 

Pada kotak dialog Create New Style from Formating isikan; 

1. Name, isikan nama style dengan Judul Bab 

2. Style type, pilih pragraf, 

3. Stale based on, pilih Heading 1,maksudnya style ini dibuat berdasarkan 

style Heading 1, 

4. Style for following paragraph , pilih Body Taks, mkasudnya jika Anda 

mengakhiri paragraf Judul Bab, dengan menekan Enter, otomatis style 

berikutnya adalah Body Teks, 

5. Formatting , lakukan pemilihan type, ukuran ,warna font, alignment, dll., 

perhatikan Gambar 1-14, 

6. Agar judul bab tertampil dengan tulisan seperti ini; 

BAB-1 : PENDAHULUAN 

7. Klik tombol Format > Numbering > Define New Number format 

parhatikan Gambar 1-15, 

8. Number style, pilih model penomorannya, 

9. Number format , sisipkan tulisan BAB-1 : , 

10. Alignment, atur rata kiri atau kanan atau tengah, 

11. Klik tombol Format > Paragraph ; atur Ali gnment, pastikan Outline 

level-1, atur Indentation dan Spacing, kemudian centrang kotak Donôt 

add space between paragraph of same style, 

12. Lalu klik tombol OK. 

13. Agar judul bab selalu berada di awal halaman, klik tab Format > 

Pargraph, lalu centang kotak Window/Orphan control  dan Page break 

befor, yang lainnya kosongkan, akhiri dengan klik tombol OK. 
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Gambar 1-15  Kotak dialog mendefinisikan penomoran Judul Bab 

 

Apabila naskah Anda telah terlanjur dibuat, maka Anda dapat mengatur 

levelnya sebagai berikut: 

1. Klik pada bagian Judul Bab, lalu klik anak panah menghadap ke kanan 

bawah. Maka akan terlihat layar Style dan style yang berlaku pada judul 

bab tersebut. 

2. Klik panah kecil disebelah kanan nama style yang dipilh, lalu akan muncul 

menu drop-down, lalu pilih Modify.  

 

Gambar 1-16  Kotak Dialog Style untuk Mengubah Style 










































